
Regular readers of these articles will have noted that I commonly use hyperlinks in my Excel files as they are a great way to move around a file.  Once you 
know how to construct them, they take seconds to insert.

The ‘Insert Hyperlink’ dialog box is fairly straightforward to use and readily accessed via one of two keyboard shortcuts, either ALT + I + I or CTRL + K.  
Alternatively, simply go to the ‘Insert’ tab on the Ribbon and click on the ‘Hyperlink’ or ‘Link’ button, depending upon which version of Excel you possess:

Hyperlinks can be used to link to a variety of places, but here, let’s focus on linking to elsewhere within the same workbook.

To create a hyperlink, first select the cell or range of cells that you wish to act as the hyperlink (i.e. clicking on any of these cells will activate the 
hyperlink).  Then, open the Insert Hyperlink dialog box (above) and select ‘Place in This Document’ as the ‘Link to:’, which will change the appearance 
of the rest of the dialog box.  

Insert the text for the hyperlink in the ‘Text to display:’ input box (clicking on the ‘ScreenTip…’ macro button will allow you to create an  
informative message in a message box when you hover over the hyperlink).

NEWSLETTER #59 - October 2017

Have you reached your Excel CEILING?  
We don’t wish to FLOOR you, but can you (CEILING) wax lyrical?  Yes, this month we look at the “top” function in Excel 
and its variants in our A to Z series, quite literally – to be CEILING.PRECISE.

We also have the world’s most comprehensive look on September’s Get & Transform updates (er, not), but still have 
time to show you how to hyperlink to charts as well.  There’s the usual features (Power BI Desktop Updates, and 
Keyboard Shortcuts) and advanced notice of our travel plans too.

More on Charts: Using Hyperlinks to Link to Chart Sheets
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The next two input boxes, ‘Type the cell reference:’ and ‘Or select a place in this document:’, work in tandem – sort of:

	 •	 If you type a cell reference in the first input box without making a selection in the second input box, the hyperlink will link to the  
		  cell reference on the current (active) worksheet
	 •	 If you type a cell reference in the first input box and select a worksheet reference in the second box, the hyperlink will link to the specified cell 	
		  in the given worksheet.  In my example above, this hyperlink will jump to Sheet1 cell A1
	 •	 If you select a ‘Defined Name’ (i.e. a pre-defined range name) in the second input box, this will link to the cell(s) specified.  This is the 	
		  recommended option, where available, if you wish to link to cell(s) on another worksheet within the same workbook. This is because if  
		  the destination worksheet’s sheet name were to be changed, the link would still work.

One interesting thing is that Excel will not let you link to chart sheets and range names cannot be attached to chart sheets – hence, seemingly no 
way to link to the worksheet.  Most model developers will circumvent this issue by embedding their charts in Excel spreadsheets and then it’s easy.  
But what if you don’t want to do this for some reason (e.g. some Management Information Systems require charts to be on their own worksheets)?

There is an Excel function, HYPERLINK(link_location,[friendly_name]), but this does not help us either as there is no cell on a chart sheet to link to.  
There is a neat workaround, however…

Add a new worksheet in the workbook, and then create a new hyperlink as follows:

	 •	 Select the cell (not cells) in the worksheet where you want the chart hyperlink to appear.  This cannot be on the worksheet just added for  
		  reasons that will become apparent below
	 •	Next, create a hyperlink that links to the worksheet just added (it doesn’t matter which cell you choose)
	 •	 The text to display selection is critical.  I will call it Critical Text 01, for this example’s sake, but please call it whatever you wish
	 •	Hide the new worksheet just added.  This will make our hyperlink ‘dead”, i.e. when you click on it, nothing will happen (hyperlinks cannot jump  
		  to hidden worksheets)
	 •	 The chart sheet name is also critical.  I will call this Critical Text 02 for identification purposes
	 •	Right click on the worksheet name in the tab for the chart sheet you wish to link from and choose ‘View Code’ from the shortcut menu.

This final step activates Excel’s Visual Basic Editor.  The following code should be copied into the Module area of the screen (the large white area 
usually located on the right-hand side):

Private Sub Worksheet_FollowHyperlink(ByVal Target As Hyperlink)

    If Target.TextToDisplay = "Critical Text 01" Then Sheets("Critical Text 02").Select

End Sub

[Critical Text 01 and Critical Text 02 should be replaced with the relevant text.]

With the hyperlink dead, clicking on a cell containing a hyperlink will merely test for the required text; if found, it will jump to the chart sheet as 
requested.

The problem with chart sheets is that there is no cell to attach a hyperlink to, so we need to get more inventive:

	 •	 Insert a text box on your chart (it can be inserted from the ‘Insert’ tab of the Ribbon, in the ‘Text’ group, ALT + N + X)
	 •	 Type in the text you want and make it appear to look like a hyperlink by formatting the text (e.g. colour blue and underline)
	 •	Right hand click on the text box and choose ‘Assign Macro…’ from the shortcut menu
	 •	 Type a name for the macro and then press the ‘Record’ button
	 •	 Select the worksheet and cell you want your “pseudo-hyperlink” to jump to
	 •	 Stop the macro using the ‘Stop Recording’ button (on the ‘Developer’ tab in the ‘Code’ group).  [N.B. If the ‘Developer’ tab is not visible, use  
		  ALT + T + O to go to the ‘Popular’ Excel Options and check the third check box, ‘Show Developer tab in the Ribbon’.]

If you want to know more, including playing with an example Excel file, visit www.sumproduct.com/thought/hyperlinking-chart-sheets for more details.

It’s been a while since we’ve travelled, but we are off and away again – pretty much for the rest of 2017!  October will see us all over 
Australia as well as in London en masse and Singapore.  Drop us a line at contact@sumproduct.com if you’d like to meet up.  We’d be 
happy to discuss your modelling / training requirements.

Out and About in October
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For those in New York, Toronto, Kuala Lumpur, Hong Kong and Johannesburg, keep watching – we’re coming to a theatre near you 
soon too.  Again, do get in touch if you’d like to meet up.  Now, which airline would like to give us free business class flights...? We’ll 
write you a lovely review / provide some free modelling…

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month we look at linking to a “well-known 
webpage”.

Whilst Power Query will allow data to be extracted from the web, for many webpages, some knowledge of HTML is needed, and even then, a great 
deal of transformation is often required to get the data into a tabular form.  However, if the page uses tables, then the data can be much easier to 
extract.  This month, we look at how to extract data from a webpage that holds information in a table. 

For my example, let’s use an excellent webpage which provides a list of training events by Excel specialists – perhaps it looks familiar?

Starting in the ‘Get External Data’ section, let’s choose to get my data ‘From the Web’.  The window that pops up gives us a choice of ‘Basic’ or 
‘Advanced’ options.  We could have used the basic option since the full web page is fairly short, but I have chosen the advanced option to show how 
webpage addresses may be built.

Power Query Pointers

Having chosen to access www.sumproduct.com/courses; we may opt to set timeouts if there appear to be problems with a particular website, but I 
will choose not to set any in this example (since I know how great this website is!).

If accessing www.sumproduct.com for the first time, then you will be prompted to confirm the authentication options, which default to ‘Anonymous’.  
It is possible to see the same authentication options from ‘Data Source Settings’ in the ‘Settings’ section as shown below:
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In this instance, I have chosen to use the anonymous setting, since the webpage viewed does not require any password or other security information.  
Future queries accessing the same website will use the existing authentication settings.

Once the authentication method has been defined, Power Query links to the webpage and returns the recognised content.

The navigator pane above shows that Power Query has identified a document and a table.  The document highlighted clearly doesn’t show any 
recognisable data about courses.  More work would be required in order to obtain useful information from this.  The table, however, proves more 
fruitful, as shown below:
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This generates a list of courses which may be edited (if required) and loaded to an Excel workbook.  I choose to skip the edit step, and create the 
following workbook:

The link to the webpage can be refreshed in the same way as other data sources.  A word of caution, however: in this case I have used a reliable 
source, which I know will be well maintained, and which will not be subject to abrupt format changes without warning.  Using content which you 
have no control over is risky and can lead to bad decisions being taken as a result of using out of date or erroneous data.  Good data can however be 
refreshed and uploaded – and this refreshing can be automated.  More on how to automate refreshes next month… 

This is the one the world has been waiting for!  Power BI Desktop finally releases two features that were demoed back at the Data Insights Summit 
that really got everyone talking: drillthrough and report insights.  That’s not all though, with a theming preview also available that many requested 
and even a new chart type (the Ribbon chart – confusing nomenclature or what!).  Another one that is likely to get tongues wagging is “Explain the 
increase / decrease insights” preview too.

Something for everyone then – well, anyone who has Power BI Desktop anyway! 

In summary, the following updates have been released: 

September 2017 Updates for Power BI Desktop

Reporting

	 •	Drillthrough to another report page
	 •	 Explain the increase / decrease insights (preview)
	 •	Ribbon chart
	 •	 Theming preview update – chart style controls
	 •	Accessibility improvement:
	 	 	 o	 Accessible See data
	 	 	 o	 Keyboard shortcut helper dialog
	 •	New community visuals 
	 •	 Cartesian gridline style control
	 •	High density scatter chart sampling
	 	 	 o	 Visio visual (preview)
	 	 	 o	 Calendar by Tallan
	 	 	 o	 Enlighten Aquarium
	 	 	 o	 Impact Bubble Chart

Data connectivity

	 •	 Azure Consumption Insights connector
	 •	 Improvements to the Dynamics 365 for Financials connector.

 Let’s take a look at each of these in turn.

Drillthrough to another report page

Here’s one the masses have been waiting for.  As we mentioned back in July’s newsletter, this is one of the new key features demoed at the Microsoft 
Data Insights Summit back in June.  Drillthrough filters allow you to create a page in your report that provides details on a single ‘entity’ in your model, 
such as a customer, manufacturer, product or location, and then use any data point referring to that ‘entity’ column through the report to navigate to 
that drillthrough page with the matching filter context.
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To create a drillthrough page, simply 
start by creating a page filled with 
charts related to the category you 
are interested in.  For example, say I 
want a page dedicated to data about 
a single manufacturer:

Once the page is made, add the category column to the Drillthrough filters area:

Now from any other page in my report where we have a chart using that same category, 
you may right-click a data point and drillthrough to the manufacturer page, viz.

When you drillthrough, you will pass 
through the specific category you 
right-clicked on as a filter on the 
drillthrough page.  In this example 
(above), since we right-clicked on a 
row where the Manufacturer was 
Adventure Works, the drillthrough 
page was filtered to display only 
Adventure Works.
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Another feature of drillthrough pages is the back button.  When you add a drillthrough filter, a back button will be automatically added to the top left 
of the report page.  When you click this button in reading mode or by using CTRL + CLICK on this button in editing mode, you will be taken back to the 
page you were on before.

This is a very useful feature for report users since it helps with navigation.  However, if you don’t want the drillthrough button, you can remove it.  In fact, 
you can also make your own back button by adding a shape or image to the report and turning on the Back button toggle:

Explain the increase / decrease insights (preview)

This is another feature released in September’s update, which was also demoed at the Microsoft Data Insights Summit.  This feature lets you right-click 
on a bar or a data point in a line chart and ask Power BI Desktop to explain why this data point increased or decreased compared to the data point before 
it.  Who needs analysts anymore?

The insights machine learning algorithms will cast their beady eyes over the data and populate a flyout with charts showing what categories most 
influenced this increase or decrease:
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With each insight, you can do a few different things.  For example, you can view the insight in different ways using the ‘chart switcher’ (honestly has 
Microsoft completely destroyed the English language – Ed.) at the bottom.  This will allow you to see the insight using a waterfall chart, scatter chart, 
stacked column chart or even new chart type, the Ribbon chart (see below).

You can provide Microsoft with feedback on the insight using the thumbs up and down icons near the top to help improve their algorithms.

Also, you can use the plus button on the top right to add an insight to your report page as a visual.  This new visual is now part of your report and can 
be changed or formatted just like all the other visuals in your report.

This insights feature is available when using the report both in reading and editing mode, so you can use it purely for analysis or as an additional tool for 
creating your reports.  Do note though that this is just a preview, so don’t be surprised if it transforms beyond all recognition in the next few months.
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Ribbon chart

There’s a new visual type in the September update: the Ribbon chart.  This new visualisation is geared towards showing rank change.  The visual is 
like a stacked column chart, but each column’s inner categories are sorted according to their rank for that column.  Additionally, the inner categories 
are connected by ribbons across the columns to help you visually see how the rank changes across the columns.

You’ll find this new chart option to the right of the combo chart:

The chart’s field well and formatting options are the same as a stacked column chart with some extra formatting options for the ribbons.  There’s a 
Ribbon card in the formatting pane that lets you control the ribbon style as follows:

	 •	 Spacing: You can use this option to set a percentage of the column’s maximum height as the gap width between the ribbons.  By default, there  
		  is no spacing.

	 •	Match series color: By default, Microsoft’s software will colour the ribbons to match the category’s colour, but this may be turned off, which will  
		  result in the ribbons becoming grey in colour instead
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	 •	 Transparency: You can control the transparency of the ribbon’s colour.  By default, this is set to 30

	 •	Border: By default, the ribbons don’t have a border, but you can turn borders on:

Theming preview update – chart style controls

Back in March, Microsoft released the first iteration of their new report theming feature.  Now, Power BI Desktop has extended this theme file format 
to include full control over chart styling.

This means you can do things like:

•	 Set all of your charts to use size 14 font
•	 Set your matrix values to use Calibri font
•	 Turn data labels on for specific charts.

This feature’s power is that you can create one theme file and almost never have to touch the formatting pane again!  Well, don’t hold us to that…

To use this extension to theming, you can add a visualStyles section to your JSON file.  Inside the visualStyles section you can define the default 
setting for each visual type’s settings.  The format looks like this:

visualStyles: {

          visualName: {

                    styleName: {

                              cardName: [{

                                        propertyName: propertyValue

                              }]

                    }

          }

}

For the visualName and cardName sections, you can either list a specific visual and cardName or using a wildcard “*” if you want the setting to apply 
to all visuals or all of the cards that could contain this property for a specific visual.  This is useful for things like font family or size that you may want 
to apply to all charts on your report.
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Microsoft has produced such a new theme you can test out and we reproduce it below.

{
          "name":"NewTheme",
          "dataColors":["#01B8AA", "#374649", "#FD625E", "#F2C80F", "#5F6B6D", #8AD4EB", "#FE9666", 
"#A66999", "#3599B8", "#DFBFBF", "#4AC5BB", "#5F6B6D", "#FB8281",  "#F4D25A", "#7F898A", "#A4DDEE", 
"#FDAB89"],
          "background":"#ffffff",
          "foreground":"#333333",
          "tableAccent":"#01B8AA",
          "visualStyles":{
                    "*":{
                              "*":{
                                        "*":[{
                                                  "responsive":true,
                                                  "wordWrap":true
                                        }],
                                        "wordWrap":[{
                                                 "show":true
                                        }]
                              }
                   },
                    "scatterChart":{
                              "*":{
                                        "fillPoint":[{
                                                  "show":true
                                        }]
                              }
                    }
          }

}

If you don’t define a default setting in your theme, it will use Power BI’s default.  This means you only need to define the defaults for the formatting 
settings you care about.  Similar to most programming languages out there, it does seem to be a case of trial and error.

Accessibility improvement: Accessible See data

An important part of consuming reports is getting at the actual data points.  Up until this point, this has been a challenge for users who can only 
access their reports using screen readers, so Microsoft has now enabled an accessible “See data” view.  You can access the accessible data behind 
the chart using the keyboard shortcut ALT + SHIFT + F11.

Once you enter this mode, your focus will be on the data table and you can navigate it using your keyboard and screenreader.
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Accessibility improvement: Keyboard shortcut helper dialog

With all the new keyboard shortcuts added over the past several months, it can be hard to keep track.  To help you remember which shortcut does 
what, Microsoft has a keyboard shortcut helper dialog that can be reached by pressing the “?” key when looking at your report:

New community visuals: Cartesian gridline style control

Microsoft has added support to style your gridlines in you charts.  This includes turning the gridlines on or off and changing the colour, stroke width 
and style.  This is an especially useful feature if you tend to create dark themed reports and need your gridlines to stand out better.  You’ll find these 
options in the formatting pane for measure axes.  You won't see this option for categorical axes, but it will affect hierarchy outlines if you have that 
feature turned on.

New community visuals: High density scatter chart sampling

Based on end user feedback, Microsoft has updated the sampling algorithm for scatter charts.  This new algorithm will better preserve the shape of 
data whilst also highlighting outliers.  To do this, Power BI Desktop prioritises showing points that aren’t going to be hidden by neighbouring points.  
With this change, you should see noticeable improvements with any scatter charts that exceed the data point limit.  This sampling algorithm allows 
you to represent a large number of data points without sacrificing performance and load time.  With big data, this may be significant.

If you would like to use the previous sampling algorithm or test out the improvements, you can turn off High Density Sampling in the ‘General’ card 
of the formatting pane.
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New community visuals: Visio visual (preview)

Downloadable from the Office store, the Visio visual provides the ability to represent Power BI data in a custom manner.  It allows you to design 
a Visio diagram showing your business process workflows or a real-world layout like your floor plan and quickly connect to it in Power BI.  The 
underlying Power BI data is automatically and intelligently linked to the diagram based on its shape properties, eliminating the need to do this 
manually.  This lets you turn your Visio diagrams into an interactive Power BI visualisation that can help you make informed decisions faster.

New community visuals: Calendar by Tallan

Another one from the Office store, the Tallan’s calendar visual is another take on displaying and slicing date data.  All you need to do is add your date 
field and measure you want to visualise per day to the visual.  The default view is a year view of all your data.

You can then zoom in on a specific month by clicking on its name:
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New community visuals: Enlighten Aquarium

Erm, not quite sure what to say about this one…  Next time you want to make an impact in your board reports, you might wish to consider the 
Enlighten Aquarium visual which has been released into the wild – sorry, I mean the Office store.  I think it’s safe to say it’s different.  In this visual, 
each fish is a different category and the size of the fish is proportional to the measure you give it.  Sounds fishy to me.

New community visuals: Impact Bubble Chart

The Impact Bubble Chart is an advanced bubble chart that lets you see how your bubbles move around the cartesian coordinate system over time.  
We don’t think the fish are an option in this one.  Each bubble represents a category and you represent that category with up to three measures using 
the Size, Left Bar length, and Right Bar length features of the chart:

Another one from the Custom Visuals store…

We dare you to include this chart in your next Board Report…
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Azure Consumption Insights connector

In the world of data connectivity, Microsoft has released a new connector for Azure Consumption Insights.  This new connector allows Azure 
Consumption Insights users to create custom reports to monitor their Azure Consumption data using Power BI.

The new Azure Consumption Insights connector can be found under the Online Services category in the Get Data dialog:

Improvements to the Dynamics 365 for Financials connector

Finally, the latest update for Power BI Desktop provides substantial enhancements to the Dynamics 365 for Financials connector. These enhancements 
include:

	 •	 Enabling Azure Active Directory based authentication, instead of previously-available Basic authentication
	 •	Auto-discovery of your Dynamics 365 for Financials endpoint, after signing in with your credentials.

The Dynamics 365 for Financials connector can be found under the Online Services category within the Get Data dialog:

More fish next month – unless they’ve had their chips…
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It’s (un)official.  Microsoft appears to have left the building.  Check out the official news on the Get & Transform update for Excel 2016 in 
September (no news for 2010 and 2013):

Have you reached your CEILING?  This function returns number rounded up, away from zero, to the nearest multiple of significance:

September 2017 Updates for Get & Transform / Power Query Add-In

The A to Z of Excel Functions: CEILING 

That’s it apparently.  Presumably, the children are off school and it’s holiday time.  
To save you the trouble of going to hunt out this fine documentation, let us save 
you the bother.  If you click through to the security update article, it provides 
“more detail” on the Get & Transform updates through a hyperlink – which leads 
you straight back to the screenshot above.  

Precisely what the new date / time / maths transformations and Index Column 
support (numbered joists?) are, we’ll have to wait and see…

For example, if you are an American (which, let’s be honest is all Microsoft really cares about) and you want to want to avoid using cents in your prices 
(that makes no cents) and your product is priced at $4.42, use the formula =CEILING(4.42, 0.05) to round prices up to the nearest nickel.

The CEILING function employs the following syntax to operate:

CEILING(number, significance)

The CEILING function has the following arguments:

	 •	 number: this is required and represents the value you wish to round
	 •	 significance: this is also required. This is the multiple used for rounding.

It should be further noted that: 

	 •	 if either argument is nonnumeric, CEILING returns the #VALUE! error value
	 •	 regardless of the sign of number, a value is rounded up when adjusted away from zero.  If number is an exact multiple of significance,  
		  no rounding occurs
	 •	 if number is negative, and significance is negative, the value is rounded down, away from zero
	 •	 if number is negative, and significance is positive, the value is rounded up towards zero.
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Please see our example below: 

This function sounds like something you calculate whilst swinging from the chandeliers.  That’s not the case though, exciting as it sounds.   
This function actually rounds a number up to the nearest integer or to the nearest multiple of significance (see below).

The A to Z of Excel Functions: CEILING.MATH 

The CEILING.MATH function employs the following syntax to operate:

CEILING.MATH(number, [significance], [mode])

The CEILING.MATH function has the following arguments:

	 •	number: this is required.  This number must be less than 9.99E+307 and greater than -2.229E-308
	 •	 significance: this is optional.  This represents the multiple to which number is to be rounded
	 •	mode: also optional.  For negative numbers, this controls whether number is rounded toward or away from zero.

It should be further noted that: 

	 •	 by default, significance is +1 for positive numbers and -1 for negative numbers
	 •	 by default, positive numbers with decimal portions are rounded up to the nearest integer.  For example, 6.3 is rounded up to 7
	 •	 by default, negative numbers with decimal portions are rounded up (toward zero) to the nearest integer.  For example, -6.7 is rounded up to -6
	 •	 by specifying the significance and mode arguments, you can change the direction of the rounding for negative numbers.  For example,  
		  rounding the number -6.3 to a significance of 1 with a mode of 1 rounds away from 0, to -7.  There are many combinations of significance 	
		  and mode values that affect rounding of negative numbers in different ways
	 •	 the mode argument does not affect positive numbers
	 •	 the significance argument rounds the number up to the nearest integer that is a multiple of the significance specified.  The exception is 	
		  where the number to be rounded is an integer.  For example, for a significance of 3 the number is rounded up to the next integer that is a 	
		  multiple of 3
	 •	 if number divided by a significance of 2 or greater results in a remainder, the result is rounded up.

More examples: 

Do you know where your CEILING is precisely??  If not, this function won’t help you.  Instead, this function returns a number that is rounded up to 
the nearest integer or to the nearest multiple of significance.  Regardless of the sign of the number, the number is rounded up.  However, if the 
number or the significance is zero, zero is returned.

The A to Z of Excel Functions: CEILING.PRECISE
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Upcoming SumProduct Training Courses

Location Course Date Duration

Sydney Power Pivot, Power Query and Power BI 16th - 18th Oct 2017 3 days

Melbourne Excel Tips & Tricks 23rd Oct 2017 1 day

Melbourne Financial Modelling 24th - 25th Oct 2017 2 days

Sydney Visual Basic for Applications 6th Nov 2017 1 day

Sydney Excel Tips & Tricks 13th Nov 2017 1 day

Sydney Financial Modelling 14th - 15th Nov 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Melbourne Excel Tips & Tricks 11th Dec 2017 1 day

Melbourne Financial Modelling 12th - 13th Dec 2017 2 days

Sydney Excel Tips & Tricks 15th Jan 2018 1 day

Sydney Financial Modelling 16th - 17th Jan 2018 2 days

Sydney Power Pivot, Power Query and Power BI 22nd - 24th Jan 2018 3 days

Melbourne Power Pivot, Power Query and Power BI 29th - 31st Jan 2018 3 days

Hobart Financial Modelling 5th - 6th Feb 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Brisbane Excel Tips & Tricks 12th Feb 2018 1 days

Brisbane Financial Modelling 13th - 14th Feb 2018 2 days

Melbourne Excel Tips & Tricks 19th Feb 2018 1 day

Melbourne Financial Modelling 20th - 21st Feb 2018 2 days

The CEILING.PRECISE function employs the following syntax to operate:

CEILING.PRECISE(number, [significance])

The CEILING.PRECISE function has the following arguments:

	 •	 number: this is required and represents the value to be rounded
	 •	 significance: this is optional.  This is the multiple to which number is to be rounded. 
		  If significance is omitted, its default value is 1.

It should be further noted that: 

	 •	 the absolute value of the multiple is used, so that the CEILING.PRECISE function returns the mathematical ceiling irrespective of the signs  
		  of number and significance.

Please our final examples for this issue: 

More next month.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we’re amidst the 
numbers 4, 5 and 6:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

CTRL + 4 Underline (toggle)

CTRL + SHIFT + 4 Currency format

CTRL + 5 Strikethrough (toggle)

CTRL + SHIFT + 5 Percentage format

CTRL + 6 Toggle Show, Hide, and Show Placeholders for Objects

CTRL + SHIFT + 6 Exponential format

Have you heard about the 
SumProduct Referral programme? 
If you successfully introduce us to a 
client we will pay you 10% of the net 
profits of the engagement won upon 
receipt of client payment. Sounds like 
a pretty good deal to us!

Terms and conditions apply.  Referrer 
must be over 18 years of age, able 
to issue an invoice and not be an 
employee, director, agent or other 
related party of the client engaged.  
For further information, drop us a line 
at  contact@sumproduct.com.  We 
hope to hear from you!

Referral Programme

Perth Financial Modelling 26th - 27th Feb 2018 2 days 

Sydney Visual Basic for Applications 12th Mar 2018 1 day

Sydney Power Pivot, Power Query and Power BI 19th - 21st Mar 2018 3 days

Adelaide Financial Modelling 5th - 6th Apr 2018 2 days 

Sydney Excel Tips & Tricks 23rd Apr 2018 1 day

Sydney Financial Modelling 26th - 27th Apr 2018 2 days

Melbourne Excel Tips & Tricks 30th Apr 2018 1 day

Melbourne Financial Modelling 1st - 2nd May 2018 2 day

Melbourne Power Pivot, Power Query and Power BI 14th - 16th May 2018 2 day

Auckland Financial Modelling 21st - 22nd May 2018 2 days

Wellington Financial Modelling 24th - 25th May 2018 2 days

Darwin Financial Modelling 4th - 5th Jun 2018 2 days

Sydney Power Pivot, Power Query and Power BI 18th - 20th Jun 2018 1 day 

Sydney Financial Modelling 25th - 26th Jun 2018 2 days
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